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Preamble
The purpose of this document is to describe the process by which one can generate semantic phenotype statements (annotations) for a taxonomic revision or
other similar product. Examples of semantic phenotype data, including character templates, are available in Mullins et al. (2012); Balhoff et al. (2013); Mikó
et al. (2014). Motivation for representing phenotype data in a form that is computable is described by Deans et al. (2015, 2012b,a). The workflow described
below is a bit ad hoc, out of necessity, pulling together tools and resources from
multiple projects. We are working to make this process—i.e., the generation of
semantic phenotype data—much more user-friendly.

Prerequisites
This workflow requires a set of taxonomic treatments in mx Yoder et al. (2015),
the details of which are described on the mx wiki (e.g., how to add characters: http://mx.phenomix.org/index.php/App/specimen) and below. One
also needs to have a working instance of Protégé (Protégé Project, 2015) and
access to relevant ontologies (anatomy, phenotype descriptors, biospatial concepts, etc.)
∗ adeans@psu.edu
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Taxonomic treatments in mx
At this stage, specimens should be digitized in mx and have OTUs, images,
sequences, etc. associated with them. One likely also has notes regarding his/her
taxon hypotheses.

Characters and matrices in mx
Characters and character states The terms “character” and “character
state” are used in mx to refer a parent phenotype and its children phenotypes
(Table 1).
character (parent)
head color
head length
labrum shape

character state 1 (child)
red
0.8–0.1 mm
circular

character state 2 (child)
black
1.5–1.6 mm
triangular

Table 1: Example characters and their states.

Matrices Matrices are used to group OTU-phenotype pairs for taxonomic
treatments and/or phylogeny. OTU-phenotype pairs can also be scored from
a matrix. Matrices designate sets of data that can be exported into the “taxonomic treatment.owl” file, described later in this document. It is smart to
generate a master matrix for all higher-level projects (e.g., separate master matrices for Evaniidae and Chalcidoidea). These master matrices will facilitate
automated generation of descriptions and diagnoses of higher taxa (also described later). Each new revision or treatment should begin with a clone of
the relevant master matrix. Whenever a new character is created during an
individual work, it should be added to the master matrix.

Producing taxonomic treatments
Content types and templates in mx One possible usage of the mx publishing tool is to generate a standardized and semi-automated results section of
a taxonomic or morphology paper—i.e., the taxonomic treatments themselves.
Content types are sections, determined by the author, of the OTU descriptions
(e.g., Head, Mesosoma, Notes, Etymology; see Figure 1) while templates define
the layout of OTU page (the order of content types in each OTU description).
Creating content types There are ‘built in’ (or dynamic) content types in
mx (Figure 2.). We primarily use 3:
1. Taxonomic name header
2. Taxonomic history header
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Figure 1: Example of template with content types. This view was generated by
navigating to the OTUs tab, clicking OTU groups link (subtab), selecting the
appropriate OTU group, clicking the ‘print’ link under ‘Descriptions’ (on the
left), and then selecting the appropriate template from the dropdown menu.
3. Material examined
One can generate further content types for free text topics, like the Diagnosis
and Comments.
A Content type has a name (it is smart to specify a name according to the
scope of its use within mx, like ‘Trissevania species description’) and a document
name (this will be the title of the OTU page layout defined by a Content type,
i.e., the actual string in the published taxon treatment). If one doesn’t provide
a Document Name mx will use the Name as the topic title. See Figure 3.
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Figure 2: A complete list of built-in content types.

Figure 3: Creating a new content type.
Mapping content types to characters Mapping character data to specific
sections (e.g. head characters generated in a ‘Head’ section) is done by mapping
Content types to Character groups (Figure 4). To start one must create a
Character group in mx.
Character Groups Managing a Character group can be done using the Character groups link on the Characters tab. Use new (in the upper right corner) for
generating new Character group. See Figure 4. Characters within a Character
group can sorted by clicking on the [drag] icon. This arrangement will define
the arrangement of characters in the generated results. Content Types can be
mapped to a Character group using the edit link (Figure 5).
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Figure 4: Example Character group on mx.
Creating Templates Once all of the required content types are available one
can create a template. Templates can be managed at the Templates link on the
content tab. Content types can be selected from the “checkable” list offered by
mx and arranged using mx [drag] icon (Figure 6).
Editing content The content itself can now be created/edited for each OTU.
Content type sections can be managed by using the content link on the left
(Figure 7). OTUs that represent undescribed taxa should not be linked to any
taxon name (although it is required that one link an OTU to a taxon when it
is created, this connection can be erased later), for the accurate appearance of
the new taxon name in the automatically generated description (using taxon
header, see later).
If the template uses content types that are automatically generated, we
start editing content by clicking the matrix syncing link of additional view/edit
options at the bottom right of the OTU content page (Figure 8).
For synchronizing automatically generated sections for the selected OTU one
has to select a Template (Figure 9). If one accepts the generated section he or
she has to check the block on the top left corner (next to unlinked update) and
click update (bottom left) (Figures 10 and 11). If the section is unacceptable
one has to edit either the character group, characters themselves, or the scoring
(i.e., the link between any OTU and its phenotype).
IMPORTANT: matrix syncing and saving (updating) of automatically
generated sections is required after every change in character, character group
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Figure 5: Mapping Content types for generated results.

Figure 6: Templates can be managed at the Templates link (subtab) under the
Content tab.
or in OTU scoring. Once the automatically generated content is synchronized
one can edit it and the free text sections by selecting the Template on the
content page of the OTU (Figures 11 and 12). After editing one must save the
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content by clicking ANY of the buttons on the top (edit, working, published,
published) (Figure 12).

Figure 7: Content link at left, highlighted in yellow.

Generating Results If one’s revision contains multiple treatments, he or she
can generate it using a selected OTU group (again, contents for each OTU has
to be saved individually before content for an OTU group is generated). The
arrangement of OTU content for multiple taxa is defined by the arrangement
of a given OTU group. Their order can be managed using the [drag] icon.
Content for multiple OTUs can be generated by clicking either the working or
print links (right column on OTU group). While working on the revision one
should examine progress using the working link. This reports a nearly identical
result to the print link but embeds links to forms or places that have outstanding
work to be completed. When the print link is clicked content types without data
are excluded. That is, it is ready for print.
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Figure 8: OTU content page (matrix syncing on the bottom right, highlighted
in yellow).
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Figure 9: Selecting Template for synchronizing the automatically generated
sections.

Figure 10: Saving and updating automatically generated sections.
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Figure 11: Selecting a Template for editing sections of Results.
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Figure 12: Managing sections of Results.
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From matrices to semantic phenotypes
With the revision complete in mx, on can now generate the semantic phenotypes
in Protégé:
1. Generate an OWL file from the taxonomic treatment in mx. Go to the
matrix in question, and right click the OWL link on the left (under ‘output’) and choose ‘save link as’. Change the filename extension to .n3,
for example ‘mx taxonomic treatment.n3’ (mx generates an N-triples file,
a format for RDF data). Be advised that some browsers might append
.html or some other extension on that file.
2. Set up a work space (i.e. directory/folder) that will contain the data
(semantic statements) and supporting files (e.g., referenced ontologies).
These data will all be connected in Protégé.
3. Add required plugins to Protégé: (a) download org.nescent.protege.cdao.jar
from https://github.com/balhoff/cdao-protege/releases (click the
green button), (b) copy the file into Protégé plugins folder (on a Mac,
right click the Protégé icon and click show package contents; to find the
plugins folder navigate to contents → resources → Java → plugins). See
Figure 13.
4. Create a new Character Annotation tab in Protégé: open Protégé and
navigate to Window → create new tab, then click return. Name the
new tab Character Annotation. Protégé should automatically display the
empty tab. Now add the following views (Window → Views →) to the
new ‘Character Annotation’ tab:

Figure 13: Installing the org.nescent.protege.cdao.jar file.
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(a) Class Views/Descriptions
(b) Individual Views/Description
(c) Individual View/Annotations
(d) Misc Views/CDAO characters
(e) Misc Views/CDAO states
After selecting each view a round cursor will be presented. Move that
cursor onto the tab and click to place the view. Your final layout should
look something like Figure 14.
5. Create a new ontology with the triple data from mx in Protégé by opening the .n3 file that was saved previously (File → open). Navigate to
the Refactor (in top menu) options and select change ontology URI. Rename the URI to something that is not anonymous, e.g. http://www.
semanticweb.org/ontologies/2014/9/sop_example. Save the ontology
in rdf/xml format: File → Save as → RDF/XML → provide a name (e.g.,
mx taxonname.owl).
6. Create a new ontology (File → New) , and name it phenotype annotation taxonname.owl.
7. Import supporting ontologies, including mx taxonname.owl: Navigate to
the Active ontology tab and use the ‘+’ button next to Direct import
to import an ontology (Figure 15. Import your domain ontology, in this

Figure 14: Screen shot of Protégé with Character Annotation window set up.
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example hao.owl. If there are new terms you created in the domain ontology be sure that it is updated at obolibrary.org and that the new version
contains the newly created concepts.
• mx taxonname.owl (stored in your project directory)
• hao.owl from http://purl.obolibrary.org/obo/hao.owl (check for
the current version at http://www.ontobee.org/browser/index.
php?o=HAO)
• pato.owl from http://purl.obolibrary.org/obo/pato.owl
• bspo.owl from http://purl.obolibrary.org/obo/bspo.owl
• ro.owl from http://purl.obolibrary.org/obo/ro.owl (this ontology will automatically initiate the import of other ontologies (n ≈
8))
• obi.owl from http://purl.obofoundry.org/obo/obi.owl
• iao.owl from http://information-artifact-ontology.googlecode.
com/svn/releases/2011-08-04/merged/iao.owl
8. Add a denotes reference. Note: Rather than importing obi.owl (http:
//purl.obolibrary.org/obo/iao.owl), one creates the object property

Figure 15: Adding supporting ontologies to Protégé.
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Figure 16: New subproperty icon (red circle).
denotes directly. This prevents some downstream problems with inference
(as of this writing OBI has issues):
(a) Click on the Object properties tab
(b) Click on topObjectProperty
(c) Click on the add new subproperty icon (Figure 16)
(d) for the name paste this URI: http://purl.org/obo/owl/IAO#IAO_
0000219, and then click OK.
(e) With the new property selected, Click (+) by Annotations and select
‘label’ on the left. Type ‘denotes’ under Value, and click OK.

Creating Semantic Phenotypes
In our system, semantic phenotypes are subclasses of Thing (i.e., the base class
for any OWL ontology).

Initiate new semantic phenotypes
1. From the character annotation tab, select a Character in the CDAO characters window. The corresponding states will be populated in CDAO
states. One might need to reconfigure the views before moving forward.
2. Select a State in CDAO states
3. Click the + next to Types in the Description window
4. Select ‘Object restriction creator’ tab in the pop-up window
5. Select Thing
6. To create a new semantic phenotype subclass click Thing then click the
+ button (the L with the two circles; see Figure 17) in the top left of
Restriction filler. Name the subclass. It is a good idea to incorporate the
mx ID of the character state; this is available in the annotations window
as a has mx id value (e.g., phenotype 123456).
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Figure 17: New semantic phenotype subclass icon (red arrow).
7. In the Restricted property panel find the ‘is about’ property, and open it.
Then select the subproperty ‘denotes’. Set the Restriction type to ‘Only
(universal)’.
8. Double check that the phenotype you created is selected in the Restriction
filler and click OK

Define the new semantic phenotype
1. Click the (+) next to the SubClass Of in the Description
2. Choose the Class Expression Editor tab in the pop-up
3. Write the Manchester syntax (MS) statement (see next section for examples) and click OK. Do this for each character state.
4. Save file as taxonname semanticannotation.owl
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Character templates
The following examples, which cover a majority of character types used in descriptive taxonomy, are lifted almost verbatim from Balhoff et al. (2013) and
Mikó et al. (2014).
Qualitative phenotypes This kind of character describes a phenotypic quality (Q) borne by a given structure (E). Natural language examples are “Eye
color: blue” and “compound eye blue”. The MS is:
has part some (E and bearer of some Q)
The blue compound eye example would be written as:
has part some (compound eye and bearer of some blue)
Presence/absence phenotypes This kind of character describe the presence
or absence of a given structure (E), for example “Antennal shelf absent”. The
MS is:
has part some E
or
not (has part some E)
The lack of an antennal shelf would be written as:
not (has part some antennal shelf )
Count phenotypes This kind of character describes the number of instances
(n) of a given structure (E), for example the number of processes (teeth) on the
mandible. Depending on what one is trying to express, the MS is:
has component exactly n E
has component min n E
has component max n E
An example with mandibular teeth could be written as:
has part some (mandible and (has component exactly 3 tooth))
Relative measurement phenotypes These characters describe the size of
one structure relative to another, allowing a character to be repeatably evaluated across organisms of differing absolute size. The characters may indicate a
directional difference in size. The MS is:
has part some (E1 and bearer of some (Q and
increased in magnitude relative to some (Q and inheres in some E2)))
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The following natural language character—Female scape length greater than
eye height—would be written as:
has part some (scape and bearer of some (length and
increased in magnitude relative to some (length and inheres in some
compound eye)))
Another example is the difference of a specific magnitude (n), expressed as
the size of one structure using the size of the other as units:
has part some (E1 and bearer of some (Q and (has measurement some
((has unit some Q and inheres in some E2) and (has magnitude value n)))))
For example this character—Long setae (length >2 × ocellus diameter)
present—would be expressed as:
has part some (seta and bearer of some (length and (has measurement some
((has unit some diameter and inheres in some ocellus) and (has magnitude
some float[>2.0f ])))))
Comparing part(s) of an anatomical structure with its other parts
Often one needs to describe the quality of part(s) of a structure relative to the
remaining part(s). Color offers perhaps the best examples of this situation:
Mandible black, with dark brown mandibular teeth. This phenotype would be
written as:
has part some (mandible and (has part some ((not tooth) and bearer of
some black)) and (has part some (tooth and bearer of some dark brown)))
Incorporating view The characterization of many phenotypes is view-dependent.
Something that looks circular in anterior view, a wasp’s head for example, may
appear rectangular in dorsal view. This character—Anterolateral mesopectal
projection 2D shape lateral view: square—requires view and would be written
in MS as:
has part some (anterolateral mesopectal projection and has part (some
lateral side and bearer of some square))

Synchronizing sequential studies
When one sees that a semantic representation can be refined without losing its
intended meaning (typically making the semantic phenotype/class more precise)
it is desirable to retroactively link this class to the earlier version. Among
other things this allows specimens to be classified into both the older and newer
classes. The following steps are done in this case:
1. Open Protégé
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2. Create a new ontology, name it something like taxon merged.owl. Select
RDF/XML as the ontology type
3. Navigate to Refactor → Ontology Name. Provide a new IRI name, and
click the Enable Version IRI.
4. Use the (+) beside the direct import button to select the previously generated semantic statement files (you need at least 2 or more)
5. Make sure the merged ontology is selected in the URL bar at the top of
the browser.
6. Navigate to View and ensure ‘Show all loaded ontologies’ is selected.
7. Navigate to the Classes window and notice that the phenotype classes
(like phenotype 1234, where 1234 is an mx character state id) from both
files show up side-by-side
8. For a given set of identically named classes, choose the first class. With
that class selected, in the class description window click the (+) next to
the Equivalent class
9. Select the Class hierarchy tab and navigate to the second class, and click
OK. Notice the two classes become equivalent.
10. Repeat this process for all sets of identically named phenotypes
11. Save the file with Save As and provide a file name. Note that you are only
saving the merged equivalences, not the other files
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Oellrich, A., Osumi-Sutherland, D., Parkinson, H., Ramı́rez, M. J., Richter,
S., Robinson, P. N., Ruttenberg, A., Schulz, K. S., Segerdell, E., Seltmann,
K. C., Sharkey, M. J., Smith, A. D., Smith, B., Specht, C. D., Squires, R. B.,
Thacker, R. W., Thessen, A., Fernandez-Triana, J., Vihinen, M., Vize, P. D.,
Vogt, L., Wall, C. E., Walls, R. L., Westerfeld, M., Wharton, R. A., Wirkner,
C. S., Woolley, J. B., Yoder, M. J., Zorn, A. M., and Mabee, P. (2015).
Finding our way through phenotypes. PLoS Biology, 13(1):e1002033.
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